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When you receive an invitation to peer review, you should be sent a copy of the paper's abstract to help you decide whether you wish to do the review. Try to respond to invitations promptly - it will prevent delays. It is also important at this stage to declare any potential Conflict of Interest.
The structure of the review report varies between journals. Some follow an informal structure, while others have a more formal approach.
" Number your comments!!! " (Jonathon Halbesleben, former Editor of Journal of Occupational and Organizational Psychology)
Informal Structure
Many journals don't provide criteria for reviews beyond asking for your 'analysis of merits'. In this case, you may wish to familiarize yourself with examples of other reviews done for the journal, which the editor should be able to provide or, as you gain experience, rely on your own evolving style.
Formal Structure
Other journals require a more formal approach. Sometimes they will ask you to address specific questions in your review via a questionnaire. Or they might want you to rate the manuscript on various attributes using a scorecard. Often you can't see these until you log in to submit your review. So when you agree to the work, it's worth checking for any journal-specific guidelines and requirements. If there are formal guidelines, let them direct the structure of your review.
In Both Cases
Whether specifically required by the reporting format or not, you should expect to compile comments to authors and possibly confidential ones to editors only.

Following the invitation to review, when you'll have received the article abstract, you should already understand the aims, key data and conclusions of the manuscript. If you don't, make a note now that you need to feedback on how to improve those sections.
The first read-through is a skim-read. It will help you form an initial impression of the paper and get a sense of whether your eventual recommendation will be to accept or reject the paper.
Keep a pen and paper handy when skim-reading.
Try to bear in mind the following questions - they'll help you form your overall impression:
	What is the main question addressed by the research? Is it relevant and interesting?
	How original is the topic? What does it add to the subject area compared with other published material?
	Is the paper well written? Is the text clear and easy to read?
	Are the conclusions consistent with the evidence and arguments presented? Do they address the main question posed?
	If the author is disagreeing significantly with the current academic consensus, do they have a substantial case? If not, what would be required to make their case credible?
	If the paper includes tables or figures, what do they add to the paper? Do they aid understanding or are they superfluous?

While you should read the whole paper, making the right choice of what to read first can save time by flagging major problems early on.
Editors say, " Specific recommendations for remedying flaws are VERY welcome ."
Examples of possibly major flaws include:
	Drawing a conclusion that is contradicted by the author's own statistical or qualitative evidence
	The use of a discredited method
	Ignoring a process that is known to have a strong influence on the area under study

If experimental design features prominently in the paper, first check that the methodology is sound - if not, this is likely to be a major flaw.
You might examine:
	The sampling in analytical papers
	The sufficient use of control experiments
	The precision of process data
	The regularity of sampling in time-dependent studies
	The validity of questions, the use of a detailed methodology and the data analysis being done systematically (in qualitative research)
	That qualitative research extends beyond the author's opinions, with sufficient descriptive elements and appropriate quotes from interviews or focus groups

Major Flaws in Information
If methodology is less of an issue, it's often a good idea to look at the data tables, figures or images first. Especially in science research, it's all about the information gathered. If there are critical flaws in this, it's very likely the manuscript will need to be rejected. Such issues include:
	Insufficient data
	Unclear data tables
	Contradictory data that either are not self-consistent or disagree with the conclusions
	Confirmatory data that adds little, if anything, to current understanding - unless strong arguments for such repetition are made

If you find a major problem, note your reasoning and clear supporting evidence (including citations).
After the initial read and using your notes, including those of any major flaws you found, draft the first two paragraphs of your review - the first summarizing the research question addressed and the second the contribution of the work. If the journal has a prescribed reporting format, this draft will still help you compose your thoughts.
The First Paragraph
This should state the main question addressed by the research and summarize the goals, approaches, and conclusions of the paper. It should:
	Help the editor properly contextualize the research and add weight to your judgement
	Show the author what key messages are conveyed to the reader, so they can be sure they are achieving what they set out to do
	Focus on successful aspects of the paper so the author gets a sense of what they've done well

The Second Paragraph
This should provide a conceptual overview of the contribution of the research. So consider:
	Is the paper's premise interesting and important?
	Are the methods used appropriate?
	Do the data support the conclusions?

After drafting these two paragraphs, you should be in a position to decide whether this manuscript is seriously flawed and should be rejected (see the next section). Or whether it is publishable in principle and merits a detailed, careful read through.
Even if you are coming to the opinion that an article has serious flaws, make sure you read the whole paper. This is very important because you may find some really positive aspects that can be communicated to the author. This could help them with future submissions.
A full read-through will also make sure that any initial concerns are indeed correct and fair. After all, you need the context of the whole paper before deciding to reject. If you still intend to recommend rejection, see the section "When recommending rejection."
Once the paper has passed your first read and you've decided the article is publishable in principle, one purpose of the second, detailed read-through is to help prepare the manuscript for publication. You may still decide to recommend rejection following a second reading.
" Offer clear suggestions for how the authors can address the concerns raised. In other words, if you're going to raise a problem, provide a solution ." (Jonathon Halbesleben, Editor of Journal of Occupational and Organizational Psychology)
Preparation
To save time and simplify the review:
	Don't rely solely upon inserting comments on the manuscript document - make separate notes
	Try to group similar concerns or praise together
	If using a review program to note directly onto the manuscript, still try grouping the concerns and praise in separate notes - it helps later
	Note line numbers of text upon which your notes are based - this helps you find items again and also aids those reading your review

Now that you have completed your preparations, you're ready to spend an hour or so reading carefully through the manuscript.
As you're reading through the manuscript for a second time, you'll need to keep in mind the argument's construction, the clarity of the language and content.
With regard to the argument’s construction, you should identify:
	Any places where the meaning is unclear or ambiguous
	Any factual errors
	Any invalid arguments

You may also wish to consider:
	Does the title properly reflect the subject of the paper?
	Does the abstract provide an accessible summary of the paper?
	Do the keywords accurately reflect the content?
	Is the paper an appropriate length?
	Are the key messages short, accurate and clear?

Not every submission is well written. Part of your role is to make sure that the text’s meaning is clear.
Editors say, " If a manuscript has many English language and editing issues, please do not try and fix it. If it is too bad, note that in your review and it should be up to the authors to have the manuscript edited ."
If the article is difficult to understand, you should have rejected it already. However, if the language is poor but you understand the core message, see if you can suggest improvements to fix the problem:
	Are there certain aspects that could be communicated better, such as parts of the discussion?
	Should the authors consider resubmitting to the same journal after language improvements?
	Would you consider looking at the paper again once these issues are dealt with?

On Grammar and Punctuation
Your primary role is judging the research content. Don't spend time polishing grammar or spelling. Editors will make sure that the text is at a high standard before publication. However, if you spot grammatical errors that affect clarity of meaning, then it's important to highlight these. Expect to suggest such amendments - it's rare for a manuscript to pass review with no corrections.
A 2010 study of nursing journals found that 79% of recommendations by reviewers were influenced by grammar and writing style (Shattel, et al., 2010).
1. The Introduction
A well-written introduction:
	Sets out the argument
	Summarizes recent research related to the topic
	Highlights gaps in current understanding or conflicts in current knowledge
	Establishes the originality of the research aims by demonstrating the need for investigations in the topic area
	Gives a clear idea of the target readership, why the research was carried out and the novelty and topicality of the manuscript

Originality and Topicality
Originality and topicality can only be established in the light of recent authoritative research. For example, it's impossible to argue that there is a conflict in current understanding by referencing articles that are 10 years old.
Authors may make the case that a topic hasn't been investigated in several years and that new research is required. This point is only valid if researchers can point to recent developments in data gathering techniques or to research in indirectly related fields that suggest the topic needs revisiting. Clearly, authors can only do this by referencing recent literature. Obviously, where older research is seminal or where aspects of the methodology rely upon it, then it is perfectly appropriate for authors to cite some older papers.
Editors say, "Is the report providing new information; is it novel or just confirmatory of well-known outcomes ?"
It's common for the introduction to end by stating the research aims. By this point you should already have a good impression of them - if the explicit aims come as a surprise, then the introduction needs improvement.
2. Materials and Methods
Academic research should be replicable, repeatable and robust - and follow best practice.
Replicable Research
This makes sufficient use of:
	Control experiments
	Repeated analyses
	Repeated experiments

These are used to make sure observed trends are not due to chance and that the same experiment could be repeated by other researchers - and result in the same outcome. Statistical analyses will not be sound if methods are not replicable. Where research is not replicable, the paper should be recommended for rejection.
Repeatable Methods
These give enough detail so that other researchers are able to carry out the same research. For example, equipment used or sampling methods should all be described in detail so that others could follow the same steps. Where methods are not detailed enough, it's usual to ask for the methods section to be revised.
Robust Research
This has enough data points to make sure the data are reliable. If there are insufficient data, it might be appropriate to recommend revision. You should also consider whether there is any in-built bias not nullified by the control experiments.
Best Practice
During these checks you should keep in mind best practice:
	Standard guidelines were followed (e.g. the CONSORT Statement for reporting randomized trials)
	The health and safety of all participants in the study was not compromised
	Ethical standards were maintained

If the research fails to reach relevant best practice standards, it's usual to recommend rejection. What's more, you don't then need to read any further.
3. Results and Discussion
This section should tell a coherent story - What happened? What was discovered or confirmed?
Certain patterns of good reporting need to be followed by the author:
	They should start by describing in simple terms what the data show
	They should make reference to statistical analyses, such as significance or goodness of fit
	Once described, they should evaluate the trends observed and explain the significance of the results to wider understanding. This can only be done by referencing published research
	The outcome should be a critical analysis of the data collected

Discussion should always, at some point, gather all the information together into a single whole. Authors should describe and discuss the overall story formed. If there are gaps or inconsistencies in the story, they should address these and suggest ways future research might confirm the findings or take the research forward.
4. Conclusions
This section is usually no more than a few paragraphs and may be presented as part of the results and discussion, or in a separate section. The conclusions should reflect upon the aims - whether they were achieved or not - and, just like the aims, should not be surprising. If the conclusions are not evidence-based, it's appropriate to ask for them to be re-written.
5. Information Gathered: Images, Graphs and Data Tables
If you find yourself looking at a piece of information from which you cannot discern a story, then you should ask for improvements in presentation. This could be an issue with titles, labels, statistical notation or image quality.
Where information is clear, you should check that:
	The results seem plausible, in case there is an error in data gathering
	The trends you can see support the paper's discussion and conclusions
	There are sufficient data. For example, in studies carried out over time are there sufficient data points to support the trends described by the author?

You should also check whether images have been edited or manipulated to emphasize the story they tell. This may be appropriate but only if authors report on how the image has been edited (e.g. by highlighting certain parts of an image). Where you feel that an image has been edited or manipulated without explanation, you should highlight this in a confidential comment to the editor in your report.
6. List of References
You will need to check referencing for accuracy, adequacy and balance.
Where a cited article is central to the author's argument, you should check the accuracy and format of the reference - and bear in mind different subject areas may use citations differently. Otherwise, it's the editor’s role to exhaustively check the reference section for accuracy and format.
You should consider if the referencing is adequate:
	Are important parts of the argument poorly supported?
	Are there published studies that show similar or dissimilar trends that should be discussed?
	If a manuscript only uses half the citations typical in its field, this may be an indicator that referencing should be improved - but don't be guided solely by quantity
	References should be relevant, recent and readily retrievable

Check for a well-balanced list of references that is:
	Helpful to the reader
	Fair to competing authors
	Not over-reliant on self-citation
	Gives due recognition to the initial discoveries and related work that led to the work under assessment

You should be able to evaluate whether the article meets the criteria for balanced referencing without looking up every reference.
7. Plagiarism
By now you will have a deep understanding of the paper's content - and you may have some concerns about plagiarism.
Identified Concern
If you find - or already knew of - a very similar paper, this may be because the author overlooked it in their own literature search. Or it may be because it is very recent or published in a journal slightly outside their usual field.
You may feel you can advise the author how to emphasize the novel aspects of their own study, so as to better differentiate it from similar research. If so, you may ask the author to discuss their aims and results, or modify their conclusions, in light of the similar article. Of course, the research similarities may be so great that they render the work unoriginal and you have no choice but to recommend rejection.
"It's very helpful when a reviewer can point out recent similar publications on the same topic by other groups, or that the authors have already published some data elsewhere ." (Editor feedback)
Suspected Concern
If you suspect plagiarism, including self-plagiarism, but cannot recall or locate exactly what is being plagiarized, notify the editor of your suspicion and ask for guidance.
Most editors have access to software that can check for plagiarism.
Editors are not out to police every paper, but when plagiarism is discovered during peer review it can be properly addressed ahead of publication. If plagiarism is discovered only after publication, the consequences are worse for both authors and readers, because a retraction may be necessary.
For detailed guidelines see COPE's Ethical guidelines for reviewers and Wiley's Best Practice Guidelines on Publishing Ethics .
8. Search Engine Optimization (SEO)
After the detailed read-through, you will be in a position to advise whether the title, abstract and key words are optimized for search purposes. In order to be effective, good SEO terms will reflect the aims of the research.
A clear title and abstract will improve the paper's search engine rankings and will influence whether the user finds and then decides to navigate to the main article. The title should contain the relevant SEO terms early on. This has a major effect on the impact of a paper, since it helps it appear in search results. A poor abstract can then lose the reader's interest and undo the benefit of an effective title - whilst the paper's abstract may appear in search results, the potential reader may go no further.
So ask yourself, while the abstract may have seemed adequate during earlier checks, does it:
	Do justice to the manuscript in this context?
	Highlight important findings sufficiently?
	Present the most interesting data?

Editors say, " Does the Abstract highlight the important findings of the study ?"
If there is a formal report format, remember to follow it. This will often comprise a range of questions followed by comment sections. Try to answer all the questions. They are there because the editor felt that they are important. If you're following an informal report format you could structure your report in three sections: summary, major issues, minor issues.
	Give positive feedback first. Authors are more likely to read your review if you do so. But don't overdo it if you will be recommending rejection
	Briefly summarize what the paper is about and what the findings are
	Try to put the findings of the paper into the context of the existing literature and current knowledge
	Indicate the significance of the work and if it is novel or mainly confirmatory
	Indicate the work's strengths, its quality and completeness
	State any major flaws or weaknesses and note any special considerations. For example, if previously held theories are being overlooked

Major Issues
	Are there any major flaws? State what they are and what the severity of their impact is on the paper
	Has similar work already been published without the authors acknowledging this?
	Are the authors presenting findings that challenge current thinking? Is the evidence they present strong enough to prove their case? Have they cited all the relevant work that would contradict their thinking and addressed it appropriately?
	If major revisions are required, try to indicate clearly what they are
	Are there any major presentational problems? Are figures & tables, language and manuscript structure all clear enough for you to accurately assess the work?
	Are there any ethical issues? If you are unsure it may be better to disclose these in the confidential comments section

Minor Issues
	Are there places where meaning is ambiguous? How can this be corrected?
	Are the correct references cited? If not, which should be cited instead/also? Are citations excessive, limited, or biased?
	Are there any factual, numerical or unit errors? If so, what are they?
	Are all tables and figures appropriate, sufficient, and correctly labelled? If not, say which are not

Your review should ultimately help the author improve their article. So be polite, honest and clear. You should also try to be objective and constructive, not subjective and destructive.
You should also:
	Write clearly and so you can be understood by people whose first language is not English
	Avoid complex or unusual words, especially ones that would even confuse native speakers
	Number your points and refer to page and line numbers in the manuscript when making specific comments
	If you have been asked to only comment on specific parts or aspects of the manuscript, you should indicate clearly which these are
	Treat the author's work the way you would like your own to be treated

Most journals give reviewers the option to provide some confidential comments to editors. Often this is where editors will want reviewers to state their recommendation - see the next section - but otherwise this area is best reserved for communicating malpractice such as suspected plagiarism, fraud, unattributed work, unethical procedures, duplicate publication, bias or other conflicts of interest.
However, this doesn't give reviewers permission to 'backstab' the author. Authors can't see this feedback and are unable to give their side of the story unless the editor asks them to. So in the spirit of fairness, write comments to editors as though authors might read them too.
Reviewers should check the preferences of individual journals as to where they want review decisions to be stated. In particular, bear in mind that some journals will not want the recommendation included in any comments to authors, as this can cause editors difficulty later - see Section 11 for more advice about working with editors.
You will normally be asked to indicate your recommendation (e.g. accept, reject, revise and resubmit, etc.) from a fixed-choice list and then to enter your comments into a separate text box.
Recommending Acceptance
If you're recommending acceptance, give details outlining why, and if there are any areas that could be improved. Don't just give a short, cursory remark such as 'great, accept'. See Improving the Manuscript
Recommending Revision
Where improvements are needed, a recommendation for major or minor revision is typical. You may also choose to state whether you opt in or out of the post-revision review too. If recommending revision, state specific changes you feel need to be made. The author can then reply to each point in turn.
Some journals offer the option to recommend rejection with the possibility of resubmission – this is most relevant where substantial, major revision is necessary.
What can reviewers do to help? " Be clear in their comments to the author (or editor) which points are absolutely critical if the paper is given an opportunity for revisio n." (Jonathon Halbesleben, Editor of Journal of Occupational and Organizational Psychology)
Recommending Rejection
If recommending rejection or major revision, state this clearly in your review (and see the next section, 'When recommending rejection').
Where manuscripts have serious flaws you should not spend any time polishing the review you've drafted or give detailed advice on presentation.
Editors say, " If a reviewer suggests a rejection, but her/his comments are not detailed or helpful, it does not help the editor in making a decision ."
In your recommendations for the author, you should:
	Give constructive feedback describing ways that they could improve the research
	Keep the focus on the research and not the author. This is an extremely important part of your job as a reviewer
	Avoid making critical confidential comments to the editor while being polite and encouraging to the author - the latter may not understand why their manuscript has been rejected. Also, they won't get feedback on how to improve their research and it could trigger an appeal

Remember to give constructive criticism even if recommending rejection. This helps developing researchers improve their work and explains to the editor why you felt the manuscript should not be published.
" When the comments seem really positive, but the recommendation is rejection…it puts the editor in a tough position of having to reject a paper when the comments make it sound like a great paper ." (Jonathon Halbesleben, Editor of Journal of Occupational and Organizational Psychology)
Visit our Wiley Author Learning and Training Channel for expert advice on peer review.
Watch the video, Ethical considerations of Peer Review
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Scientific review articles are comprehensive, focused reviews of the scientific literature written by subject matter experts. The task of writing a scientific review article can seem overwhelming; however, it can be managed by using an organized approach and devoting sufficient time to the process. The process involves selecting a topic about which the authors are knowledgeable and enthusiastic, conducting a literature search and critical analysis of the literature, and writing the article, which is composed of an abstract, introduction, body, and conclusion, with accompanying tables and figures. This article, which focuses on the narrative or traditional literature review, is intended to serve as a guide with practical steps for new writers. Tips for success are also discussed, including selecting a focused topic, maintaining objectivity and balance while writing, avoiding tedious data presentation in a laundry list format, moving from descriptions of the literature to critical analysis, avoiding simplistic conclusions, and budgeting time for the overall process.
Scientific review articles provide a focused and comprehensive review of the available evidence about a subject, explain the current state of knowledge, and identify gaps that could be topics for potential future research.
Detailed tables reviewing the relevant scientific literature are important components of high-quality scientific review articles.
Tips for success include selecting a focused topic, maintaining objectivity and balance, avoiding tedious data presentation, providing a critical analysis rather than only a description of the literature, avoiding simplistic conclusions, and budgeting time for the overall process.
The process of researching and writing a scientific review article can be a seemingly daunting task but can be made manageable, and even enjoyable, if an organized approach is used and a reasonable timeline is given. Scientific review articles provide authors with an opportunity to synthesize the available evidence about a specific subject, contribute their insights to the field, and identify opportunities for future research. The authors, in turn, gain recognition as subject matter experts and thought leaders in the field. An additional benefit to the authors is that high-quality review articles can often be cited many years after publication ( 1 , 2 ). The reader of a scientific review article should gain an understanding of the current state of knowledge on the subject, points of controversy, and research questions that have yet to be answered ( 3 ).
There are two types of review articles, narrative or traditional literature reviews and systematic reviews, which may or may not be accompanied by a meta-analysis ( 4 ). This article, which focuses on the narrative or traditional literature review, is intended to serve as a guide with practical steps for new writers. It is geared toward breast imaging radiologists who are preparing to write a scientific review article for the Journal of Breast Imaging but can also be used by any writer, reviewer, or reader. In the narrative or traditional literature review, the available scientific literature is synthesized and no new data are presented. This article first discusses the process of selecting an appropriate topic. Then, practical tips for conducting a literature search and analyzing the literature are provided. The structure of a scientific review article is outlined and tips for success are described.
Scientific review articles are often solicited by journal editors and written by experts in the field. For solicited or invited articles, a senior expert in the field may be contacted and, in turn, may ask junior faculty or trainees to help with the literature search and writing process. Most journals also consider proposals for review article topics. The journal’s editorial office can be contacted via e-mail with a topic proposal, ideally with an accompanying outline or an extended abstract to help explain the proposal.
When selecting a topic for a scientific review article, the following considerations should be taken into account: The authors should be knowledgeable about and interested in the topic; the journal’s audience should be interested in the topic; and the topic should be focused, with a sufficient number of current research studies ( Figure 1 ). For the Journal of Breast Imaging , a scientific review article on breast MRI would be too broad in scope. Examples of more focused topics include abbreviated breast MRI ( 5 ), concerns about gadolinium deposition in the setting of screening MRI ( 6 ), Breast Imaging Reporting and Data System (BI-RADS) 3 assessments on MRI ( 7 , 8 ), the science of background parenchymal enhancement ( 9 ), and screening MRI in women at intermediate risk ( 10 ).

Summary of the factors to consider when selecting a topic for a scientific review article. Adapted with permission from Dhillon et al ( 2 ).
Once a well-defined topic is selected, the next step is to conduct a literature search. There are multiple indexing databases that can be used for a literature search, including PubMed, SCOPUS, and Web of Science ( 11–13 ). A list of databases with links can be found on the National Institutes of Health website ( 14 ). It is advised to keep track of the search terms that are used so that the search could be replicated if needed.
While reading articles, taking notes and keeping track of findings in a spreadsheet or database can be helpful. The following points should be considered for each article: What is the purpose of the article, and is it relevant to the review article topic? What was the study design (eg, retrospective analysis, randomized controlled trial)? Are the conclusions that are drawn based on the presented data valid and reasonable? What are the strengths and limitations of the study? In the discussion section, do the authors discuss other literature that both supports and contradicts their findings? It can also be helpful to read accompanying editorials, if available, that are written by experts to explain the importance of the original scientific article in the context of other work in the field.
If previous review articles on the same topic are discovered during the literature search, then the following strategies could be considered: discussing approaches used and limitations of past reviews, identifying a new angle that has not been previously covered, and/or focusing on new research that has been published since the most recent reviews on the topic ( 3 ). It is highly encouraged to create an outline and solicit feedback from co-authors before writing begins.
Writing a high-quality scientific review article is “a balancing act between the scientific rigor needed to select and critically appraise original studies, and the art of telling a story by providing context, exploring the known and the unknown, and pointing the way forward” ( 15 ). The ideal scientific review article is balanced and authoritative and serves as a definitive reference on the topic. Review articles tend to be 4000 to 5000 words in length, with 80% to 90% devoted to the body.
When preparing a scientific review article, writers can consider using the Scale for the Assessment of Narrative Review Articles, which has been proposed as a critical appraisal tool to help editors, reviewers, and readers assess non–systematic review articles ( 16 ). It is composed of the following six items, which are rated from 0 to 2 (with 0 being low quality and 2 being high quality): explanation of why the article is important, statement of aims or questions to be addressed, description of the literature search strategy, inclusion of appropriate references, scientific reasoning, and appropriate data presentation. In a study with three raters each reviewing 30 articles, the scale was felt to be feasible in daily editorial work and had high inter-rater reliability.
The components of a scientific review article include the abstract, introduction, body, conclusion, references, tables, and figures, which are described below.
Abstracts are typically structured as a single paragraph, ranging from 200 to 250 words in length. The abstract briefly explains why the topic is important, provides a summary of the main conclusions that are being drawn based on the research studies that were included and analyzed in the review article, and describes how the article is organized ( 17 ). Because the abstract should provide a summary of the main conclusions being drawn, it is often written last, after the other sections of the article have been completed. It does not include references.
The introduction provides detailed background about the topic and outlines the objectives of the review article. It is important to explain why the literature on that topic should be reviewed (eg, no prior reviews, different angle from prior reviews, new published research). The problem-gap-hook approach can be used, in which the topic is introduced, the gap is explained (eg, lack of published synthesis), and the hook (or why it matters) is provided ( 18 ). If there are prior review articles on the topic, particularly recent ones, then the authors are encouraged to justify how their review contributes to the existing literature. The content in the introduction section should be supported with references, but specific findings from recent research studies are typically not described, instead being discussed in depth in the body.
In a traditional or narrative review article, a methods section is optional. The methods section should include a list of the databases and years that were searched, search terms that were used, and a summary of the inclusion and exclusion criteria for articles ( 17 , 19 ).
The body can take different forms depending on the topic but should be organized into sections with subheadings, with each subsection having an independent introduction and conclusion. In the body, published studies should be reviewed in detail and in an organized fashion. In general, each paragraph should begin with a thesis statement or main point, and the sentences that follow it should consist of supporting evidence drawn from the literature. Research studies need not be discussed in chronological order, and the results from one research study may be discussed in different sections of the body. For example, if writing a scientific review article on screening digital breast tomosynthesis, cancer detection rates reported in one study may be discussed in a separate paragraph from the false-positive rates that were reported in the same study.
Emphasis should be placed on the significance of the study results in the broader context of the subject. The strengths and weaknesses of individual studies should be discussed. An example of this type of discussion is as follows: “Smith et al found no differences in re-excision rates among breast cancer patients who did and did not undergo preoperative MRI. However, there were several important limitations of this study. The radiologists were not required to have breast MRI interpretation experience, nor was it required that MRI-detected findings undergo biopsy prior to surgery.” Other examples of phrases that can be used for constructive criticism are available online ( 20 ).
The conclusion section ties everything together and clearly states the conclusions that are being drawn based on the research studies included and analyzed in the article. The authors are also encouraged to provide their views on future research, important challenges, and unanswered questions.
Scientific review articles tend to have a large number of supporting references (up to 100). When possible, referencing the original article (rather than a review article referring to the original article) is preferred. The use of a reference manager, such as EndNote (Clarivate, London, UK) ( 21 ), Mendeley Desktop (Elsevier, Amsterdam, the Netherlands) ( 22 ), Paperpile (Paperpile LLC, Cambridge, MA) ( 23 ), RefWorks (ProQuest, Ann Arbor, MI) ( 24 ), or Zotero (Corporation for Digital Scholarship, Fairfax, VA) ( 25 ), is highly encouraged, as it ensures appropriate reference ordering even when text is moved or added and can facilitate the switching of formats based on journal requirements ( 26 ).
Tables and Figures
The inclusion of tables and figures can improve the readability of the review. Detailed tables that review the scientific literature are expected ( Table 1 ). A table listing gaps in knowledge as potential areas for future research may also be included ( 17 ). Although scientific review articles are not expected to be as figure-rich as educational review articles, figures can be beneficial to illustrate complex concepts and summarize or synthesize relevant data ( Figure 2 ). Of note, if nonoriginal figures are used, permission from the copyright owner must be obtained.
Example of an Effective Table From a Scientific Review Article About Screening MRI in Women at Intermediate Risk of Breast Cancer.
Abbreviations: ADH, atypical ductal hyperplasia; ALH, atypical lobular hyperplasia; CDR, cancer detection rate; LCIS, lobular carcinoma in situ; NR, not reported; PPV, positive predictive value. NOTE: The Detailed Table Provides a Summary of the Relevant Scientific Literature on Screening MRI in women with lobular neoplasia or ADH. Adapted with permission from Bahl ( 10 ).
a The reported CDR is an incremental CDR in the studies by Friedlander et al and Chikarmane et al. In all studies, some, but not all, included patients had a prior MRI examination, so the reported CDR represents a combination of both the prevalent and incident CDRs.
b This study included 455 patients with LCIS (some of whom had concurrent ALH or ADH). Twenty-nine cancers were MRI-detected, and 115 benign biopsies were prompted by MRI findings.

Example of an effective figure from a scientific review article about breast cancer risk assessment. The figure provides a risk assessment algorithm for breast cancer. Reprinted with permission from Kim et al ( 28 ).
Select a Focused but Broad Enough Topic
A common pitfall is to be too ambitious in scope, resulting in a very time-consuming literature search and superficial coverage of some aspects of the topic. The ideal topic should be focused enough to be manageable but with a large enough body of available research to justify the need for a review article. One article on the topic of scientific reviews suggests that at least 15 to 20 relevant research papers published within the previous five years should be easily identifiable to warrant writing a review article ( 2 ).
Provide a Summary of Main Conclusions in the Abstract
Another common pitfall is to only introduce the topic and provide a roadmap for the article in the abstract. The abstract should also provide a summary of the main conclusions that are being drawn based on the research studies that were included and analyzed in the review article.
Be Objective
The content and key points of the article should be based on the published scientific literature and not biased toward one’s personal opinion.
Avoid Tedious Data Presentation
Extensive lists of statements about the findings of other authors (eg, author A found Z, author B found Y, while author C found X, etc) make it difficult for the reader to understand and follow the article. It is best for the writing to be thematic based on research findings rather than author-centered ( 27 ). Each paragraph in the body should begin with a thesis statement or main point, and the sentences that follow should consist of supporting evidence drawn from the literature. For example, in a scientific review article about artificial intelligence (AI) for screening mammography, one approach would be to write that article A found a higher cancer detection rate, higher efficiency, and a lower false-positive rate with use of the AI algorithm and article B found a similar cancer detection rate and higher efficiency, while article C found a higher cancer detection rate and higher false-positive rate. Rather, a better approach would be to write one or more paragraphs summarizing the literature on cancer detection rates, one or more paragraphs on false-positive rates, and one or more paragraphs on efficiency. The results from one study (eg, article A) need not all be discussed in the same paragraph.
Move from Description (Summary) to Analysis
A common pitfall is to describe and summarize the published literature without providing a critical analysis. The purpose of the narrative or traditional review article is not only to summarize relevant discoveries but also to synthesize the literature, discuss its limitations and implications, and speculate on the future.
Avoid Simplistic Conclusions
The scientific review article’s conclusions should consider the complexity of the topic and the quality of the evidence. When describing a study’s findings, it is best to use language that reflects the quality of the evidence rather than making definitive statements. For example, rather than stating that “The use of preoperative breast MRI leads to a reduction in re-excision rates,” the following comments could be made: “Two single-institution retrospective studies found that preoperative MRI was associated with lower rates of positive surgical margins, which suggests that preoperative MRI may lead to reduced re-excision rates. Larger studies with randomization of patients are needed to validate these findings.”
Budget Time for Researching, Synthesizing, and Writing
The amount of time necessary to write a high-quality scientific review article can easily be underestimated. The process of searching for and synthesizing the scientific literature on a topic can take weeks to months to complete depending on the number of authors involved in this process.
Scientific review articles are common in the medical literature and can serve as definitive references on the topic for other scientists, clinicians, and trainees. The first step in the process of preparing a scientific review article is to select a focused topic. This step is followed by a literature search and critical analysis of the published data. The components of the article include an abstract, introduction, body, and conclusion, with the majority devoted to the body, in which the relevant literature is reviewed in detail. The article should be objective and balanced, with summaries and critical analysis of the available evidence. Budgeting time for researching, synthesizing, and writing; taking advantage of the resources listed in this article and available online; and soliciting feedback from co-authors at various stages of the process (eg, after an outline is created) can help new writers produce high-quality scientific review articles.
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How to write a review article?
In the medical sciences, the importance of review articles is rising. When clinicians want to update their knowledge and generate guidelines about a topic, they frequently use reviews as a starting point. The value of a review is associated with what has been done, what has been found and how these findings are presented. Before asking ‘how,’ the question of ‘why’ is more important when starting to write a review. The main and fundamental purpose of writing a review is to create a readable synthesis of the best resources available in the literature for an important research question or a current area of research. Although the idea of writing a review is attractive, it is important to spend time identifying the important questions. Good review methods are critical because they provide an unbiased point of view for the reader regarding the current literature. There is a consensus that a review should be written in a systematic fashion, a notion that is usually followed. In a systematic review with a focused question, the research methods must be clearly described. A ‘methodological filter’ is the best method for identifying the best working style for a research question, and this method reduces the workload when surveying the literature. An essential part of the review process is differentiating good research from bad and leaning on the results of the better studies. The ideal way to synthesize studies is to perform a meta-analysis. In conclusion, when writing a review, it is best to clearly focus on fixed ideas, to use a procedural and critical approach to the literature and to express your findings in an attractive way.
The importance of review articles in health sciences is increasing day by day. Clinicians frequently benefit from review articles to update their knowledge in their field of specialization, and use these articles as a starting point for formulating guidelines. [ 1 , 2 ] The institutions which provide financial support for further investigations resort to these reviews to reveal the need for these researches. [ 3 ] As is the case with all other researches, the value of a review article is related to what is achieved, what is found, and the way of communicating this information. A few studies have evaluated the quality of review articles. Murlow evaluated 50 review articles published in 1985, and 1986, and revealed that none of them had complied with clear-cut scientific criteria. [ 4 ] In 1996 an international group that analyzed articles, demonstrated the aspects of review articles, and meta-analyses that had not complied with scientific criteria, and elaborated QUOROM (QUality Of Reporting Of Meta-analyses) statement which focused on meta-analyses of randomized controlled studies. [ 5 ] Later on this guideline was updated, and named as PRISMA (Preferred Reporting Items for Systematic Reviews and Meta-Analyses). [ 6 ]
Review articles are divided into 2 categories as narrative, and systematic reviews. Narrative reviews are written in an easily readable format, and allow consideration of the subject matter within a large spectrum. However in a systematic review, a very detailed, and comprehensive literature surveying is performed on the selected topic. [ 7 , 8 ] Since it is a result of a more detailed literature surveying with relatively lesser involvement of author’s bias, systematic reviews are considered as gold standard articles. Systematic reviews can be diivded into qualitative, and quantitative reviews. In both of them detailed literature surveying is performed. However in quantitative reviews, study data are collected, and statistically evaluated (ie. meta-analysis). [ 8 ]
Before inquring for the method of preparation of a review article, it is more logical to investigate the motivation behind writing the review article in question. The fundamental rationale of writing a review article is to make a readable synthesis of the best literature sources on an important research inquiry or a topic. This simple definition of a review article contains the following key elements:
	The question(s) to be dealt with
	Methods used to find out, and select the best quality researches so as to respond to these questions.
	To synthetize available, but quite different researches

For the specification of important questions to be answered, number of literature references to be consulted should be more or less determined. Discussions should be conducted with colleagues in the same area of interest, and time should be reserved for the solution of the problem(s). Though starting to write the review article promptly seems to be very alluring, the time you spend for the determination of important issues won’t be a waste of time. [ 9 ]
The PRISMA statement [ 6 ] elaborated to write a well-designed review articles contains a 27-item checklist ( Table 1 ). It will be reasonable to fulfill the requirements of these items during preparation of a review article or a meta-analysis. Thus preparation of a comprehensible article with a high-quality scientific content can be feasible.
PRISMA statement: A 27-item checklist
Contents and format
Important differences exist between systematic, and non-systematic reviews which especially arise from methodologies used in the description of the literature sources. A non-systematic review means use of articles collected for years with the recommendations of your colleagues, while systematic review is based on struggles to search for, and find the best possible researches which will respond to the questions predetermined at the start of the review.
Though a consensus has been reached about the systematic design of the review articles, studies revealed that most of them had not been written in a systematic format. McAlister et al. analyzed review articles in 6 medical journals, and disclosed that in less than one fourth of the review articles, methods of description, evaluation or synthesis of evidence had been provided, one third of them had focused on a clinical topic, and only half of them had provided quantitative data about the extend of the potential benefits. [ 10 ]
Use of proper methodologies in review articles is important in that readers assume an objective attitude towards updated information. We can confront two problems while we are using data from researches in order to answer certain questions. Firstly, we can be prejudiced during selection of research articles or these articles might be biased. To minimize this risk, methodologies used in our reviews should allow us to define, and use researches with minimal degree of bias. The second problem is that, most of the researches have been performed with small sample sizes. In statistical methods in meta-analyses, available researches are combined to increase the statistical power of the study. The problematic aspect of a non-systematic review is that our tendency to give biased responses to the questions, in other words we apt to select the studies with known or favourite results, rather than the best quality investigations among them.
As is the case with many research articles, general format of a systematic review on a single subject includes sections of Introduction, Methods, Results, and Discussion ( Table 2 ).
Structure of a systematic review
Preparation of the review article
Steps, and targets of constructing a good review article are listed in Table 3 . To write a good review article the items in Table 3 should be implemented step by step. [ 11 – 13 ]
Steps of a systematic review
The research question
It might be helpful to divide the research question into components. The most prevalently used format for questions related to the treatment is PICO (P - Patient, Problem or Population; I-Intervention; C-appropriate Comparisons, and O-Outcome measures) procedure. For example In female patients (P) with stress urinary incontinence, comparisons (C) between transobturator, and retropubic midurethral tension-free band surgery (I) as for patients’ satisfaction (O).
Finding Studies
In a systematic review on a focused question, methods of investigation used should be clearly specified.
Ideally, research methods, investigated databases, and key words should be described in the final report. Different databases are used dependent on the topic analyzed. In most of the clinical topics, Medline should be surveyed. However searching through Embase and CINAHL can be also appropriate.
While determining appropriate terms for surveying, PICO elements of the issue to be sought may guide the process. Since in general we are interested in more than one outcome, P, and I can be key elements. In this case we should think about synonyms of P, and I elements, and combine them with a conjunction AND.
One method which might alleviate the workload of surveying process is “methodological filter” which aims to find the best investigation method for each research question. A good example of this method can be found in PubMed interface of Medline. The Clinical Queries tool offers empirically developed filters for five different inquiries as guidelines for etiology, diagnosis, treatment, prognosis or clinical prediction.
Evaluation of the Quality of the Study
As an indispensable component of the review process is to discriminate good, and bad quality researches from each other, and the outcomes should be based on better qualified researches, as far as possible. To achieve this goal you should know the best possible evidence for each type of question The first component of the quality is its general planning/design of the study. General planning/design of a cohort study, a case series or normal study demonstrates variations.
A hierarchy of evidence for different research questions is presented in Table 4 . However this hierarchy is only a first step. After you find good quality research articles, you won’t need to read all the rest of other articles which saves you tons of time. [ 14 ]
Determination of levels of evidence based on the type of the research question
Formulating a Synthesis
Rarely all researches arrive at the same conclusion. In this case a solution should be found. However it is risky to make a decision based on the votes of absolute majority. Indeed, a well-performed large scale study, and a weakly designed one are weighed on the same scale. Therefore, ideally a meta-analysis should be performed to solve apparent differences. Ideally, first of all, one should be focused on the largest, and higher quality study, then other studies should be compared with this basic study.
Conclusions
In conclusion, during writing process of a review article, the procedures to be achieved can be indicated as follows: 1) Get rid of fixed ideas, and obsessions from your head, and view the subject from a large perspective. 2) Research articles in the literature should be approached with a methodological, and critical attitude and 3) finally data should be explained in an attractive way.
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The Preferred Reporting Items for Systematic reviews and Meta-Analyses (PRISMA) statement, published in 2009, was designed to help systematic reviewers transparently report why the review was done, what the authors did, and what they found. Over the past decade, advances in systematic review methodology and terminology have necessitated an update to the guideline. The PRISMA 2020 statement replaces the 2009 statement and includes new reporting guidance that reflects advances in methods to identify, select, appraise, and synthesise studies. The structure and presentation of the items have been modified to facilitate implementation. In this article, we present the PRISMA 2020 27-item checklist, an expanded checklist that details reporting recommendations for each item, the PRISMA 2020 abstract checklist, and the revised flow diagrams for original and updated reviews.
Systematic reviews serve many critical roles. They can provide syntheses of the state of knowledge in a field, from which future research priorities can be identified; they can address questions that otherwise could not be answered by individual studies; they can identify problems in primary research that should be rectified in future studies; and they can generate or evaluate theories about how or why phenomena occur. Systematic reviews therefore generate various types of knowledge for different users of reviews (such as patients, healthcare providers, researchers, and policy makers). 1 2 To ensure a systematic review is valuable to users, authors should prepare a transparent, complete, and accurate account of why the review was done, what they did (such as how studies were identified and selected) and what they found (such as characteristics of contributing studies and results of meta-analyses). Up-to-date reporting guidance facilitates authors achieving this. 3
The Preferred Reporting Items for Systematic reviews and Meta-Analyses (PRISMA) statement published in 2009 (hereafter referred to as PRISMA 2009) 4 5 6 7 8 9 10 is a reporting guideline designed to address poor reporting of systematic reviews. 11 The PRISMA 2009 statement comprised a checklist of 27 items recommended for reporting in systematic reviews and an “explanation and elaboration” paper 12 13 14 15 16 providing additional reporting guidance for each item, along with exemplars of reporting. The recommendations have been widely endorsed and adopted, as evidenced by its co-publication in multiple journals, citation in over 60 000 reports (Scopus, August 2020), endorsement from almost 200 journals and systematic review organisations, and adoption in various disciplines. Evidence from observational studies suggests that use of the PRISMA 2009 statement is associated with more complete reporting of systematic reviews, 17 18 19 20 although more could be done to improve adherence to the guideline. 21
Many innovations in the conduct of systematic reviews have occurred since publication of the PRISMA 2009 statement. For example, technological advances have enabled the use of natural language processing and machine learning to identify relevant evidence, 22 23 24 methods have been proposed to synthesise and present findings when meta-analysis is not possible or appropriate, 25 26 27 and new methods have been developed to assess the risk of bias in results of included studies. 28 29 Evidence on sources of bias in systematic reviews has accrued, culminating in the development of new tools to appraise the conduct of systematic reviews. 30 31 Terminology used to describe particular review processes has also evolved, as in the shift from assessing “quality” to assessing “certainty” in the body of evidence. 32 In addition, the publishing landscape has transformed, with multiple avenues now available for registering and disseminating systematic review protocols, 33 34 disseminating reports of systematic reviews, and sharing data and materials, such as preprint servers and publicly accessible repositories. To capture these advances in the reporting of systematic reviews necessitated an update to the PRISMA 2009 statement.
Summary points
To ensure a systematic review is valuable to users, authors should prepare a transparent, complete, and accurate account of why the review was done, what they did, and what they found
The PRISMA 2020 statement provides updated reporting guidance for systematic reviews that reflects advances in methods to identify, select, appraise, and synthesise studies
The PRISMA 2020 statement consists of a 27-item checklist, an expanded checklist that details reporting recommendations for each item, the PRISMA 2020 abstract checklist, and revised flow diagrams for original and updated reviews
We anticipate that the PRISMA 2020 statement will benefit authors, editors, and peer reviewers of systematic reviews, and different users of reviews, including guideline developers, policy makers, healthcare providers, patients, and other stakeholders
Development of PRISMA 2020
A complete description of the methods used to develop PRISMA 2020 is available elsewhere. 35 We identified PRISMA 2009 items that were often reported incompletely by examining the results of studies investigating the transparency of reporting of published reviews. 17 21 36 37 We identified possible modifications to the PRISMA 2009 statement by reviewing 60 documents providing reporting guidance for systematic reviews (including reporting guidelines, handbooks, tools, and meta-research studies). 38 These reviews of the literature were used to inform the content of a survey with suggested possible modifications to the 27 items in PRISMA 2009 and possible additional items. Respondents were asked whether they believed we should keep each PRISMA 2009 item as is, modify it, or remove it, and whether we should add each additional item. Systematic review methodologists and journal editors were invited to complete the online survey (110 of 220 invited responded). We discussed proposed content and wording of the PRISMA 2020 statement, as informed by the review and survey results, at a 21-member, two-day, in-person meeting in September 2018 in Edinburgh, Scotland. Throughout 2019 and 2020, we circulated an initial draft and five revisions of the checklist and explanation and elaboration paper to co-authors for feedback. In April 2020, we invited 22 systematic reviewers who had expressed interest in providing feedback on the PRISMA 2020 checklist to share their views (via an online survey) on the layout and terminology used in a preliminary version of the checklist. Feedback was received from 15 individuals and considered by the first author, and any revisions deemed necessary were incorporated before the final version was approved and endorsed by all co-authors.
The PRISMA 2020 statement
Scope of the guideline.
The PRISMA 2020 statement has been designed primarily for systematic reviews of studies that evaluate the effects of health interventions, irrespective of the design of the included studies. However, the checklist items are applicable to reports of systematic reviews evaluating other interventions (such as social or educational interventions), and many items are applicable to systematic reviews with objectives other than evaluating interventions (such as evaluating aetiology, prevalence, or prognosis). PRISMA 2020 is intended for use in systematic reviews that include synthesis (such as pairwise meta-analysis or other statistical synthesis methods) or do not include synthesis (for example, because only one eligible study is identified). The PRISMA 2020 items are relevant for mixed-methods systematic reviews (which include quantitative and qualitative studies), but reporting guidelines addressing the presentation and synthesis of qualitative data should also be consulted. 39 40 PRISMA 2020 can be used for original systematic reviews, updated systematic reviews, or continually updated (“living”) systematic reviews. However, for updated and living systematic reviews, there may be some additional considerations that need to be addressed. Where there is relevant content from other reporting guidelines, we reference these guidelines within the items in the explanation and elaboration paper 41 (such as PRISMA-Search 42 in items 6 and 7, Synthesis without meta-analysis (SWiM) reporting guideline 27 in item 13d). Box 1 includes a glossary of terms used throughout the PRISMA 2020 statement.
Glossary of terms
Systematic review —A review that uses explicit, systematic methods to collate and synthesise findings of studies that address a clearly formulated question 43
Statistical synthesis —The combination of quantitative results of two or more studies. This encompasses meta-analysis of effect estimates (described below) and other methods, such as combining P values, calculating the range and distribution of observed effects, and vote counting based on the direction of effect (see McKenzie and Brennan 25 for a description of each method)
Meta-analysis of effect estimates —A statistical technique used to synthesise results when study effect estimates and their variances are available, yielding a quantitative summary of results 25
Outcome —An event or measurement collected for participants in a study (such as quality of life, mortality)
Result —The combination of a point estimate (such as a mean difference, risk ratio, or proportion) and a measure of its precision (such as a confidence/credible interval) for a particular outcome
Report —A document (paper or electronic) supplying information about a particular study. It could be a journal article, preprint, conference abstract, study register entry, clinical study report, dissertation, unpublished manuscript, government report, or any other document providing relevant information
Record —The title or abstract (or both) of a report indexed in a database or website (such as a title or abstract for an article indexed in Medline). Records that refer to the same report (such as the same journal article) are “duplicates”; however, records that refer to reports that are merely similar (such as a similar abstract submitted to two different conferences) should be considered unique.
Study —An investigation, such as a clinical trial, that includes a defined group of participants and one or more interventions and outcomes. A “study” might have multiple reports. For example, reports could include the protocol, statistical analysis plan, baseline characteristics, results for the primary outcome, results for harms, results for secondary outcomes, and results for additional mediator and moderator analyses
PRISMA 2020 is not intended to guide systematic review conduct, for which comprehensive resources are available. 43 44 45 46 However, familiarity with PRISMA 2020 is useful when planning and conducting systematic reviews to ensure that all recommended information is captured. PRISMA 2020 should not be used to assess the conduct or methodological quality of systematic reviews; other tools exist for this purpose. 30 31 Furthermore, PRISMA 2020 is not intended to inform the reporting of systematic review protocols, for which a separate statement is available (PRISMA for Protocols (PRISMA-P) 2015 statement 47 48 ). Finally, extensions to the PRISMA 2009 statement have been developed to guide reporting of network meta-analyses, 49 meta-analyses of individual participant data, 50 systematic reviews of harms, 51 systematic reviews of diagnostic test accuracy studies, 52 and scoping reviews 53 ; for these types of reviews we recommend authors report their review in accordance with the recommendations in PRISMA 2020 along with the guidance specific to the extension.
How to use PRISMA 2020
The PRISMA 2020 statement (including the checklists, explanation and elaboration, and flow diagram) replaces the PRISMA 2009 statement, which should no longer be used. Box 2 summarises noteworthy changes from the PRISMA 2009 statement. The PRISMA 2020 checklist includes seven sections with 27 items, some of which include sub-items ( table 1 ). A checklist for journal and conference abstracts for systematic reviews is included in PRISMA 2020. This abstract checklist is an update of the 2013 PRISMA for Abstracts statement, 54 reflecting new and modified content in PRISMA 2020 ( table 2 ). A template PRISMA flow diagram is provided, which can be modified depending on whether the systematic review is original or updated ( fig 1 ).
Noteworthy changes to the PRISMA 2009 statement
Inclusion of the abstract reporting checklist within PRISMA 2020 (see item #2 and table 2 ).
Movement of the ‘Protocol and registration’ item from the start of the Methods section of the checklist to a new Other section, with addition of a sub-item recommending authors describe amendments to information provided at registration or in the protocol (see item #24a-24c).
Modification of the ‘Search’ item to recommend authors present full search strategies for all databases, registers and websites searched, not just at least one database (see item #7).
Modification of the ‘Study selection’ item in the Methods section to emphasise the reporting of how many reviewers screened each record and each report retrieved, whether they worked independently, and if applicable, details of automation tools used in the process (see item #8).
Addition of a sub-item to the ‘Data items’ item recommending authors report how outcomes were defined, which results were sought, and methods for selecting a subset of results from included studies (see item #10a).
Splitting of the ‘Synthesis of results’ item in the Methods section into six sub-items recommending authors describe: the processes used to decide which studies were eligible for each synthesis; any methods required to prepare the data for synthesis; any methods used to tabulate or visually display results of individual studies and syntheses; any methods used to synthesise results; any methods used to explore possible causes of heterogeneity among study results (such as subgroup analysis, meta-regression); and any sensitivity analyses used to assess robustness of the synthesised results (see item #13a-13f).
Addition of a sub-item to the ‘Study selection’ item in the Results section recommending authors cite studies that might appear to meet the inclusion criteria, but which were excluded, and explain why they were excluded (see item #16b).
Splitting of the ‘Synthesis of results’ item in the Results section into four sub-items recommending authors: briefly summarise the characteristics and risk of bias among studies contributing to the synthesis; present results of all statistical syntheses conducted; present results of any investigations of possible causes of heterogeneity among study results; and present results of any sensitivity analyses (see item #20a-20d).
Addition of new items recommending authors report methods for and results of an assessment of certainty (or confidence) in the body of evidence for an outcome (see items #15 and #22).
Addition of a new item recommending authors declare any competing interests (see item #26).
Addition of a new item recommending authors indicate whether data, analytic code and other materials used in the review are publicly available and if so, where they can be found (see item #27).
PRISMA 2020 item checklist
	View inline
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PRISMA 2020 flow diagram template for systematic reviews. The new design is adapted from flow diagrams proposed by Boers, 55 Mayo-Wilson et al. 56 and Stovold et al. 57 The boxes in grey should only be completed if applicable; otherwise they should be removed from the flow diagram. Note that a “report” could be a journal article, preprint, conference abstract, study register entry, clinical study report, dissertation, unpublished manuscript, government report or any other document providing relevant information.
	Download figure
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We recommend authors refer to PRISMA 2020 early in the writing process, because prospective consideration of the items may help to ensure that all the items are addressed. To help keep track of which items have been reported, the PRISMA statement website ( http://www.prisma-statement.org/ ) includes fillable templates of the checklists to download and complete (also available in the data supplement on bmj.com). We have also created a web application that allows users to complete the checklist via a user-friendly interface 58 (available at https://prisma.shinyapps.io/checklist/ and adapted from the Transparency Checklist app 59 ). The completed checklist can be exported to Word or PDF. Editable templates of the flow diagram can also be downloaded from the PRISMA statement website.
We have prepared an updated explanation and elaboration paper, in which we explain why reporting of each item is recommended and present bullet points that detail the reporting recommendations (which we refer to as elements). 41 The bullet-point structure is new to PRISMA 2020 and has been adopted to facilitate implementation of the guidance. 60 61 An expanded checklist, which comprises an abridged version of the elements presented in the explanation and elaboration paper, with references and some examples removed, is available in the data supplement on bmj.com. Consulting the explanation and elaboration paper is recommended if further clarity or information is required.
Journals and publishers might impose word and section limits, and limits on the number of tables and figures allowed in the main report. In such cases, if the relevant information for some items already appears in a publicly accessible review protocol, referring to the protocol may suffice. Alternatively, placing detailed descriptions of the methods used or additional results (such as for less critical outcomes) in supplementary files is recommended. Ideally, supplementary files should be deposited to a general-purpose or institutional open-access repository that provides free and permanent access to the material (such as Open Science Framework, Dryad, figshare). A reference or link to the additional information should be included in the main report. Finally, although PRISMA 2020 provides a template for where information might be located, the suggested location should not be seen as prescriptive; the guiding principle is to ensure the information is reported.
Use of PRISMA 2020 has the potential to benefit many stakeholders. Complete reporting allows readers to assess the appropriateness of the methods, and therefore the trustworthiness of the findings. Presenting and summarising characteristics of studies contributing to a synthesis allows healthcare providers and policy makers to evaluate the applicability of the findings to their setting. Describing the certainty in the body of evidence for an outcome and the implications of findings should help policy makers, managers, and other decision makers formulate appropriate recommendations for practice or policy. Complete reporting of all PRISMA 2020 items also facilitates replication and review updates, as well as inclusion of systematic reviews in overviews (of systematic reviews) and guidelines, so teams can leverage work that is already done and decrease research waste. 36 62 63
We updated the PRISMA 2009 statement by adapting the EQUATOR Network’s guidance for developing health research reporting guidelines. 64 We evaluated the reporting completeness of published systematic reviews, 17 21 36 37 reviewed the items included in other documents providing guidance for systematic reviews, 38 surveyed systematic review methodologists and journal editors for their views on how to revise the original PRISMA statement, 35 discussed the findings at an in-person meeting, and prepared this document through an iterative process. Our recommendations are informed by the reviews and survey conducted before the in-person meeting, theoretical considerations about which items facilitate replication and help users assess the risk of bias and applicability of systematic reviews, and co-authors’ experience with authoring and using systematic reviews.
Various strategies to increase the use of reporting guidelines and improve reporting have been proposed. They include educators introducing reporting guidelines into graduate curricula to promote good reporting habits of early career scientists 65 ; journal editors and regulators endorsing use of reporting guidelines 18 ; peer reviewers evaluating adherence to reporting guidelines 61 66 ; journals requiring authors to indicate where in their manuscript they have adhered to each reporting item 67 ; and authors using online writing tools that prompt complete reporting at the writing stage. 60 Multi-pronged interventions, where more than one of these strategies are combined, may be more effective (such as completion of checklists coupled with editorial checks). 68 However, of 31 interventions proposed to increase adherence to reporting guidelines, the effects of only 11 have been evaluated, mostly in observational studies at high risk of bias due to confounding. 69 It is therefore unclear which strategies should be used. Future research might explore barriers and facilitators to the use of PRISMA 2020 by authors, editors, and peer reviewers, designing interventions that address the identified barriers, and evaluating those interventions using randomised trials. To inform possible revisions to the guideline, it would also be valuable to conduct think-aloud studies 70 to understand how systematic reviewers interpret the items, and reliability studies to identify items where there is varied interpretation of the items.
We encourage readers to submit evidence that informs any of the recommendations in PRISMA 2020 (via the PRISMA statement website: http://www.prisma-statement.org/ ). To enhance accessibility of PRISMA 2020, several translations of the guideline are under way (see available translations at the PRISMA statement website). We encourage journal editors and publishers to raise awareness of PRISMA 2020 (for example, by referring to it in journal “Instructions to authors”), endorsing its use, advising editors and peer reviewers to evaluate submitted systematic reviews against the PRISMA 2020 checklists, and making changes to journal policies to accommodate the new reporting recommendations. We recommend existing PRISMA extensions 47 49 50 51 52 53 71 72 be updated to reflect PRISMA 2020 and advise developers of new PRISMA extensions to use PRISMA 2020 as the foundation document.
We anticipate that the PRISMA 2020 statement will benefit authors, editors, and peer reviewers of systematic reviews, and different users of reviews, including guideline developers, policy makers, healthcare providers, patients, and other stakeholders. Ultimately, we hope that uptake of the guideline will lead to more transparent, complete, and accurate reporting of systematic reviews, thus facilitating evidence based decision making.
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Background: Literature reviews play a significant role in healthcare practice. There are different types of reviews available depending on the nature of the research question and the extent of reviewing that is conducted. In this article, we have summarized the major types of literature reviews, their strength and weakness, and provide representative examples. Methods: We have examined the different types of common reviews that have been used in the health research literature. We collected the information on these review types and have summarized them with providing corresponding examples. Results: We have discussed the major types of reviews: literature review, critical review, scoping review, systematic review, meta-analysis, qualitative systematic review, realist review, and review of reviews. We have mentioned the usability, strengths and weaknesses, utilizing the Search, Appraisal, Synthesis, Analysis (SALSA) framework, and have provided corresponding examples for each of these types of reviews in different tables. Conclusion: This article is a summary of different types of reviews and their implication in practice. This paper is thus intended for beginners who want to know about literature reviews. Introduction Literature reviews are becoming more and more important and favoured in the evidencebased practice (EBP) of health and social care 1. Healthcare professionals require updated information regarding research and development to inform their practice. However, with such large amounts of materials being published, it is impossible for anyone to cover every single piece of information or evidence on any given topic. A literature review thus gives audiences the opportunity to have summarized information on any topic without reading all of the evidence published in that specific area. Although the culture of the review article began more than two centuries ago, it wasn't until the 20th century that an explicit method was devised to carry out review research 2. In addition, the emergence of EBP instigated more rigorous and quality controlled approaches of review articles so that the synthesized summary results could be utilized with confidence 3 .
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How to Write an Article Review
Last Updated: September 8, 2023 Fact Checked
This article was co-authored by Jake Adams . Jake Adams is an academic tutor and the owner of Simplifi EDU, a Santa Monica, California based online tutoring business offering learning resources and online tutors for academic subjects K-College, SAT & ACT prep, and college admissions applications. With over 14 years of professional tutoring experience, Jake is dedicated to providing his clients the very best online tutoring experience and access to a network of excellent undergraduate and graduate-level tutors from top colleges all over the nation. Jake holds a BS in International Business and Marketing from Pepperdine University. There are 13 references cited in this article, which can be found at the bottom of the page. This article has been fact-checked, ensuring the accuracy of any cited facts and confirming the authority of its sources. This article has been viewed 3,067,130 times.
An article review is both a summary and an evaluation of another writer's article. Teachers often assign article reviews to introduce students to the work of experts in the field. Experts also are often asked to review the work of other professionals. Understanding the main points and arguments of the article is essential for an accurate summation. Logical evaluation of the article's main theme, supporting arguments, and implications for further research is an important element of a review . Here are a few guidelines for writing an article review.
Education specialist Alexander Peterman recommends: "In the case of a review, your objective should be to reflect on the effectiveness of what has already been written, rather than writing to inform your audience about a subject."
Things You Should Know
	Read the article very closely, and then take time to reflect on your evaluation. Consider whether the article effectively achieves what it set out to.
	Write out a full article review by completing your intro, summary, evaluation, and conclusion. Don't forget to add a title, too!
	Proofread your review for mistakes (like grammar and usage), while also cutting down on needless information. [1] X Research source

Preparing to Write Your Review

	Article reviews present more than just an opinion. You will engage with the text to create a response to the scholarly writer's ideas. You will respond to and use ideas, theories, and research from your studies. Your critique of the article will be based on proof and your own thoughtful reasoning.
	An article review only responds to the author's research. It typically does not provide any new research. However, if you are correcting misleading or otherwise incorrect points, some new data may be presented.
	An article review both summarizes and evaluates the article.


	Summarize the article. Focus on the important points, claims, and information.
	Discuss the positive aspects of the article. Think about what the author does well, good points she makes, and insightful observations.
	Identify contradictions, gaps, and inconsistencies in the text. Determine if there is enough data or research included to support the author's claims. Find any unanswered questions left in the article.


	Make note of words or issues you don't understand and questions you have.
	Look up terms or concepts you are unfamiliar with, so you can fully understand the article. Read about concepts in-depth to make sure you understand their full context.


	Pay careful attention to the meaning of the article. Make sure you fully understand the article. The only way to write a good article review is to understand the article.


	With either method, make an outline of the main points made in the article and the supporting research or arguments. It is strictly a restatement of the main points of the article and does not include your opinions.
	After putting the article in your own words, decide which parts of the article you want to discuss in your review. You can focus on the theoretical approach, the content, the presentation or interpretation of evidence, or the style. You will always discuss the main issues of the article, but you can sometimes also focus on certain aspects. This comes in handy if you want to focus the review towards the content of a course.
	Review the summary outline to eliminate unnecessary items. Erase or cross out the less important arguments or supplemental information. Your revised summary can serve as the basis for the summary you provide at the beginning of your review.


	What does the article set out to do?
	What is the theoretical framework or assumptions?
	Are the central concepts clearly defined?
	How adequate is the evidence?
	How does the article fit into the literature and field?
	Does it advance the knowledge of the subject?
	How clear is the author's writing? Don't: include superficial opinions or your personal reaction. Do: pay attention to your biases, so you can overcome them.

Writing the Article Review

	For example, in MLA , a citation may look like: Duvall, John N. "The (Super)Marketplace of Images: Television as Unmediated Mediation in DeLillo's White Noise ." Arizona Quarterly 50.3 (1994): 127-53. Print. [10] X Trustworthy Source Purdue Online Writing Lab Trusted resource for writing and citation guidelines Go to source


	For example: The article, "Condom use will increase the spread of AIDS," was written by Anthony Zimmerman, a Catholic priest.


	Your introduction should only be 10-25% of your review.
	End the introduction with your thesis. Your thesis should address the above issues. For example: Although the author has some good points, his article is biased and contains some misinterpretation of data from others’ analysis of the effectiveness of the condom.


	Use direct quotes from the author sparingly.
	Review the summary you have written. Read over your summary many times to ensure that your words are an accurate description of the author's article.


	Support your critique with evidence from the article or other texts.
	The summary portion is very important for your critique. You must make the author's argument clear in the summary section for your evaluation to make sense.
	Remember, this is not where you say if you liked the article or not. You are assessing the significance and relevance of the article.
	Use a topic sentence and supportive arguments for each opinion. For example, you might address a particular strength in the first sentence of the opinion section, followed by several sentences elaborating on the significance of the point.


	This should only be about 10% of your overall essay.
	For example: This critical review has evaluated the article "Condom use will increase the spread of AIDS" by Anthony Zimmerman. The arguments in the article show the presence of bias, prejudice, argumentative writing without supporting details, and misinformation. These points weaken the author’s arguments and reduce his credibility.


	Make sure you have identified and discussed the 3-4 key issues in the article.
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If you have to write an article review, read through the original article closely, taking notes and highlighting important sections as you read. Next, rewrite the article in your own words, either in a long paragraph or as an outline. Open your article review by citing the article, then write an introduction which states the article’s thesis. Next, summarize the article, followed by your opinion about whether the article was clear, thorough, and useful. Finish with a paragraph that summarizes the main points of the article and your opinions. To learn more about what to include in your personal critique of the article, keep reading the article! Did this summary help you? Yes No
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How to Write an Article Review: Tips and Examples

Did you know that article reviews are not just academic exercises but also a valuable skill in today's information age? In a world inundated with content, being able to dissect and evaluate articles critically can help you separate the wheat from the chaff. Whether you're a student aiming to excel in your coursework or a professional looking to stay well-informed, mastering the art of writing article reviews is an invaluable skill.
Short Description
In this article, our research paper writing service experts will start by unraveling the concept of article reviews and discussing the various types. You'll also gain insights into the art of formatting your review effectively. To ensure you're well-prepared, we'll take you through the pre-writing process, offering tips on setting the stage for your review. But it doesn't stop there. You'll find a practical example of an article review to help you grasp the concepts in action. To complete your journey, we'll guide you through the post-writing process, equipping you with essential proofreading techniques to ensure your work shines with clarity and precision!
What Is an Article Review: Grasping the Concept 
A review article is a type of professional paper writing that demands a high level of in-depth analysis and a well-structured presentation of arguments. It is a critical, constructive evaluation of literature in a particular field through summary, classification, analysis, and comparison.
If you write a scientific review, you have to use database searches to portray the research. Your primary goal is to summarize everything and present a clear understanding of the topic you've been working on.
Writing Involves:
	Summarization, classification, analysis, critiques, and comparison.
	The analysis, evaluation, and comparison require the use of theories, ideas, and research relevant to the subject area of the article.
	It is also worth nothing if a review does not introduce new information, but instead presents a response to another writer's work.
	Check out other samples to gain a better understanding of how to review the article.

Types of Review
When it comes to article reviews, there's more than one way to approach the task. Understanding the various types of reviews is like having a versatile toolkit at your disposal. In this section, we'll walk you through the different dimensions of review types, each offering a unique perspective and purpose. Whether you're dissecting a scholarly article, critiquing a piece of literature, or evaluating a product, you'll discover the diverse landscape of article reviews and how to navigate it effectively.

Journal Article Review
Just like other types of reviews, a journal article review assesses the merits and shortcomings of a published work. To illustrate, consider a review of an academic paper on climate change, where the writer meticulously analyzes and interprets the article's significance within the context of environmental science.
Research Article Review
Distinguished by its focus on research methodologies, a research article review scrutinizes the techniques used in a study and evaluates them in light of the subsequent analysis and critique. For instance, when reviewing a research article on the effects of a new drug, the reviewer would delve into the methods employed to gather data and assess their reliability.
Science Article Review
In the realm of scientific literature, a science article review encompasses a wide array of subjects. Scientific publications often provide extensive background information, which can be instrumental in conducting a comprehensive analysis. For example, when reviewing an article about the latest breakthroughs in genetics, the reviewer may draw upon the background knowledge provided to facilitate a more in-depth evaluation of the publication.
Need a Hand From Professionals?
Address to Our Writers and Get Assistance in Any Questions!
Formatting an Article Review
The format of the article should always adhere to the citation style required by your professor. If you're not sure, seek clarification on the preferred format and ask him to clarify several other pointers to complete the formatting of an article review adequately.
How Many Publications Should You Review?
	In what format should you cite your articles (MLA, APA, ASA, Chicago, etc.)?
	What length should your review be?
	Should you include a summary, critique, or personal opinion in your assignment?
	Do you need to call attention to a theme or central idea within the articles?
	Does your instructor require background information?

When you know the answers to these questions, you may start writing your assignment. Below are examples of MLA and APA formats, as those are the two most common citation styles.
Using the APA Format
Articles appear most commonly in academic journals, newspapers, and websites. If you write an article review in the APA format, you will need to write bibliographical entries for the sources you use:
	Web : Author [last name], A.A [first and middle initial]. (Year, Month, Date of Publication). Title. Retrieved from {link}
	Journal : Author [last name], A.A [first and middle initial]. (Publication Year). Publication Title. Periodical Title, Volume(Issue), pp.-pp.
	Newspaper : Author [last name], A.A [first and middle initial]. (Year, Month, Date of Publication). Publication Title. Magazine Title, pp. xx-xx.

Using MLA Format
	Web : Last, First Middle Initial. “Publication Title.” Website Title. Website Publisher, Date Month Year Published. Web. Date Month Year Accessed.
	Newspaper : Last, First M. “Publication Title.” Newspaper Title [City] Date, Month, Year Published: Page(s). Print.
	Journal : Last, First M. “Publication Title.” Journal Title Series Volume. Issue (Year Published): Page(s). Database Name. Web. Date Month Year Accessed.

Enhance your writing effortlessly with EssayPro.com , where you can order an article review or any other writing task. Our team of expert writers specializes in various fields, ensuring your work is not just summarized, but deeply analyzed and professionally presented. Ideal for students and professionals alike, EssayPro offers top-notch writing assistance tailored to your needs. Elevate your writing today with our skilled team at your article review writing service !

The Pre-Writing Process
Facing this task for the first time can really get confusing and can leave you unsure of where to begin. To create a top-notch article review, start with a few preparatory steps. Here are the two main stages from our dissertation services to get you started:
Step 1: Define the right organization for your review. Knowing the future setup of your paper will help you define how you should read the article. Here are the steps to follow:
	Summarize the article — seek out the main points, ideas, claims, and general information presented in the article.
	Define the positive points — identify the strong aspects, ideas, and insightful observations the author has made.
	Find the gaps —- determine whether or not the author has any contradictions, gaps, or inconsistencies in the article and evaluate whether or not he or she used a sufficient amount of arguments and information to support his or her ideas.
	Identify unanswered questions — finally, identify if there are any questions left unanswered after reading the piece.

Step 2: Move on and review the article. Here is a small and simple guide to help you do it right:
	Start off by looking at and assessing the title of the piece, its abstract, introductory part, headings and subheadings, opening sentences in its paragraphs, and its conclusion.
	First, read only the beginning and the ending of the piece (introduction and conclusion). These are the parts where authors include all of their key arguments and points. Therefore, if you start with reading these parts, it will give you a good sense of the author's main points.
	Finally, read the article fully.

These three steps make up most of the prewriting process. After you are done with them, you can move on to writing your own review—and we are going to guide you through the writing process as well.
Outline and Template
As you progress with reading your article, organize your thoughts into coherent sections in an outline. As you read, jot down important facts, contributions, or contradictions. Identify the shortcomings and strengths of your publication. Begin to map your outline accordingly.
If your professor does not want a summary section or a personal critique section, then you must alleviate those parts from your writing. Much like other assignments, an article review must contain an introduction, a body, and a conclusion. Thus, you might consider dividing your outline according to these sections as well as subheadings within the body. If you find yourself troubled with the pre-writing and the brainstorming process for this assignment, seek out a sample outline.
Your custom essay must contain these constituent parts:
	Pre-Title Page - Before diving into your review, start with essential details: article type, publication title, and author names with affiliations (position, department, institution, location, and email). Include corresponding author info if needed.
	Running Head - In APA format, use a concise title (under 40 characters) to ensure consistent formatting.
	Summary Page - Optional but useful. Summarize the article in 800 words, covering background, purpose, results, and methodology, avoiding verbatim text or references.
	Title Page - Include the full title, a 250-word abstract, and 4-6 keywords for discoverability.
	Introduction - Set the stage with an engaging overview of the article.
	Body - Organize your analysis with headings and subheadings.
	Works Cited/References - Properly cite all sources used in your review.
	Optional Suggested Reading Page - If permitted, suggest further readings for in-depth exploration.
	Tables and Figure Legends (if instructed by the professor) - Include visuals when requested by your professor for clarity.

Example of an Article Review
You might wonder why we've dedicated a section of this article to discuss an article review sample. Not everyone may realize it, but examining multiple well-constructed examples of review articles is a crucial step in the writing process. In the following section, our essay writing service experts will explain why.
Looking through relevant article review examples can be beneficial for you in the following ways:
	To get you introduced to the key works of experts in your field.
	To help you identify the key people engaged in a particular field of science.
	To help you define what significant discoveries and advances were made in your field.
	To help you unveil the major gaps within the existing knowledge of your field—which contributes to finding fresh solutions.
	To help you find solid references and arguments for your own review.
	To help you generate some ideas about any further field of research.
	To help you gain a better understanding of the area and become an expert in this specific field.
	To get a clear idea of how to write a good review.

View Our Writer’s Sample Before Crafting Your Own!
Why Have There Been No Great Female Artists?
Steps for Writing an Article Review
Here is a guide with critique paper format on how to write a review paper:

Step 1: Write the Title
First of all, you need to write a title that reflects the main focus of your work. Respectively, the title can be either interrogative, descriptive, or declarative.
Step 2: Cite the Article
Next, create a proper citation for the reviewed article and input it following the title. At this step, the most important thing to keep in mind is the style of citation specified by your instructor in the requirements for the paper. For example, an article citation in the MLA style should look as follows:
Author's last and first name. "The title of the article." Journal's title and issue(publication date): page(s). Print
Abraham John. "The World of Dreams." Virginia Quarterly 60.2(1991): 125-67. Print.
Step 3: Article Identification
After your citation, you need to include the identification of your reviewed article:
	Title of the article
	Title of the journal
	Year of publication

All of this information should be included in the first paragraph of your paper.
The report "Poverty increases school drop-outs" was written by Brian Faith – a Health officer – in 2000.
Step 4: Introduction
Your organization in an assignment like this is of the utmost importance. Before embarking on your writing process, you should outline your assignment or use an article review template to organize your thoughts coherently.
	If you are wondering how to start an article review, begin with an introduction that mentions the article and your thesis for the review.
	Follow up with a summary of the main points of the article.
	Highlight the positive aspects and facts presented in the publication.
	Critique the publication by identifying gaps, contradictions, disparities in the text, and unanswered questions.

Step 5: Summarize the Article
Make a summary of the article by revisiting what the author has written about. Note any relevant facts and findings from the article. Include the author's conclusions in this section.
Step 6: Critique It
Present the strengths and weaknesses you have found in the publication. Highlight the knowledge that the author has contributed to the field. Also, write about any gaps and/or contradictions you have found in the article. Take a standpoint of either supporting or not supporting the author's assertions, but back up your arguments with facts and relevant theories that are pertinent to that area of knowledge. Rubrics and templates can also be used to evaluate and grade the person who wrote the article.
Step 7: Craft a Conclusion
In this section, revisit the critical points of your piece, your findings in the article, and your critique. Also, write about the accuracy, validity, and relevance of the results of the article review. Present a way forward for future research in the field of study. Before submitting your article, keep these pointers in mind:
	As you read the article, highlight the key points. This will help you pinpoint the article's main argument and the evidence that they used to support that argument.
	While you write your review, use evidence from your sources to make a point. This is best done using direct quotations.
	Select quotes and supporting evidence adequately and use direct quotations sparingly. Take time to analyze the article adequately.
	Every time you reference a publication or use a direct quotation, use a parenthetical citation to avoid accidentally plagiarizing your article.
	Re-read your piece a day after you finish writing it. This will help you to spot grammar mistakes and to notice any flaws in your organization.
	Use a spell-checker and get a second opinion on your paper.

The Post-Writing Process: Proofread Your Work
Finally, when all of the parts of your article review are set and ready, you have one last thing to take care of — proofreading. Although students often neglect this step, proofreading is a vital part of the writing process and will help you polish your paper to ensure that there are no mistakes or inconsistencies.
To proofread your paper properly, start by reading it fully and checking the following points:
	Punctuation
	Other mistakes

Afterward, take a moment to check for any unnecessary information in your paper and, if found, consider removing it to streamline your content. Finally, double-check that you've covered at least 3-4 key points in your discussion.
And remember, if you ever need help with proofreading, rewriting your essay, or even want to buy essay , our friendly team is always here to assist you.
Need an Article REVIEW WRITTEN?
Just send us the requirements to your paper and watch one of our writers crafting an original paper for you.
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Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print.  To do this, you will start with baseline content in a document, potentially via a form template.  Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to database information.  Following are the recommended action steps in sequence.  
Show the Developer tab
In Word, be sure you have the Developer tab displayed in the ribbon.  (See how here:  Show the developer tab .)
Open a template or a blank document on which to base the form
You can start with a template or just start from scratch with a blank document.
Start with a form template
Go to File > New .
In the  Search for online templates  field, type  Forms or the kind of form you want. Then press Enter .
In the displayed results, right-click any item, then select  Create. 
Start with a blank document 
Select Blank document .
Add content to the form
Go to the  Developer  tab Controls section where you can choose controls to add to your document or form. Hover over any icon therein to see what control type it represents. The various control types are described below. You can set properties on a control once it has been inserted.
To delete a content control, right-click it, then select Remove content control  in the pop-up menu. 
Note:  You can print a form that was created via content controls. However, the boxes around the content controls will not print.
Insert a text control
The rich text content control enables users to format text (e.g., bold, italic) and type multiple paragraphs. To limit these capabilities, use the plain text content control . 
Click or tap where you want to insert the control.

To learn about setting specific properties on these controls, see Set or change properties for content controls .
Insert a picture control
A picture control is most often used for templates, but you can also add a picture control to a form.

Insert a building block control
Use a building block control  when you want users to choose a specific block of text. These are helpful when you need to add different boilerplate text depending on the document's specific purpose. You can create rich text content controls for each version of the boilerplate text, and then use a building block control as the container for the rich text content controls.

Select Developer and content controls for the building block.

Insert a combo box or a drop-down list
In a combo box, users can select from a list of choices that you provide or they can type in their own information. In a drop-down list, users can only select from the list of choices.

Select the content control, and then select Properties .
To create a list of choices, select Add under Drop-Down List Properties .
Type a choice in Display Name , such as Yes , No , or Maybe .
Repeat this step until all of the choices are in the drop-down list.
Fill in any other properties that you want.
Note:  If you select the Contents cannot be edited check box, users won’t be able to click a choice.
Insert a date picker
Click or tap where you want to insert the date picker control.

Insert a check box
Click or tap where you want to insert the check box control.

Use the legacy form controls
Legacy form controls are for compatibility with older versions of Word and consist of legacy form and Active X controls.
Click or tap where you want to insert a legacy control.

Select the Legacy Form control or Active X Control that you want to include.
Set or change properties for content controls
Each content control has properties that you can set or change. For example, the Date Picker control offers options for the format you want to use to display the date.
Select the content control that you want to change.
Go to Developer > Properties .

Change the properties that you want.
Add protection to a form
If you want to limit how much others can edit or format a form, use the Restrict Editing command:
Open the form that you want to lock or protect.
Select Developer > Restrict Editing .

After selecting restrictions, select Yes, Start Enforcing Protection .

Advanced Tip:
If you want to protect only parts of the document, separate the document into sections and only protect the sections you want.
To do this, choose Select Sections in the Restrict Editing panel. For more info on sections, see Insert a section break .

If the developer tab isn't displayed in the ribbon, see Show the Developer tab .
Open a template or use a blank document
To create a form in Word that others can fill out, start with a template or document and add content controls. Content controls include things like check boxes, text boxes, and drop-down lists. If you’re familiar with databases, these content controls can even be linked to data.
Go to File > New from Template .

In Search, type form .
Double-click the template you want to use.
Select File > Save As , and pick a location to save the form.
In Save As , type a file name and then select Save .
Start with a blank document
Go to File > New Document .

Go to File > Save As .
Go to Developer , and then choose the controls that you want to add to the document or form. To remove a content control, select the control and press Delete. You can set Options on controls once inserted. From Options, you can add entry and exit macros to run when users interact with the controls, as well as list items for combo boxes, .
Adding content controls to your form
In the document, click or tap where you want to add a content control.
On Developer , select Text Box , Check Box , or Combo Box .

To set specific properties for the control, select Options , and set .
Repeat steps 1 through 3 for each control that you want to add.
Set options
Options let you set common settings, as well as control specific settings. Select a control and then select Options to set up or make changes.
Set common properties.
Select Macro to Run on lets you choose a recorded or custom macro to run on Entry or Exit from the field.
Bookmark Set a unique name or bookmark for each control.
Calculate on exit This forces Word to run or refresh any calculations, such as total price when the user exits the field.
Add Help Text Give hints or instructions for each field.
OK Saves settings and exits the panel.
Cancel Forgets changes and exits the panel.
Set specific properties for a Text box
Type Select form Regular text, Number, Date, Current Date, Current Time, or Calculation.
Default text sets optional instructional text that's displayed in the text box before the user types in the field. Set Text box enabled to allow the user to enter text into the field.
Maximum length sets the length of text that a user can enter. The default is Unlimited .
Text format can set whether text automatically formats to Uppercase , Lowercase , First capital, or Title case .
Text box enabled Lets the user enter text into a field. If there is default text, user text replaces it.
Set specific properties for a Check box .
Default Value Choose between Not checked or checked as default.
Checkbox size Set a size Exactly or Auto to change size as needed.
Check box enabled Lets the user check or clear the text box.
Set specific properties for a Combo box
Drop-down item Type in strings for the list box items. Press + or Enter to add an item to the list.
Items in drop-down list Shows your current list. Select an item and use the up or down arrows to change the order, Press - to remove a selected item.
Drop-down enabled Lets the user open the combo box and make selections.
Protect the form
Go to Developer > Protect Form .

Note:  To unprotect the form and continue editing, select Protect Form again.
Save and close the form.
Test the form (optional)
If you want, you can test the form before you distribute it.
Protect the form.
Reopen the form, fill it out as the user would, and then save a copy.
Creating fillable forms isn’t available in Word for the web.
You can create the form with the desktop version of Word with the instructions in Create a fillable form .
When you save the document and reopen it in Word for the web, you’ll see the changes you made.

Need more help?
Want more options.
Explore subscription benefits, browse training courses, learn how to secure your device, and more.

Microsoft 365 subscription benefits

Microsoft 365 training

Microsoft security

Accessibility center
Communities help you ask and answer questions, give feedback, and hear from experts with rich knowledge.

Ask the Microsoft Community

Microsoft Tech Community

Windows Insiders
Microsoft 365 Insiders
Was this information helpful?
Thank you for your feedback.
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2. MOTIVATE YOUR RESEARCH in addition to providing useful information about your topic, your literature review must tell a story about how your project relates to existing literature. popular literature review narratives include: ¡ plugging a gap / filling a hole within an incomplete literature ¡ building a bridge between two "siloed" literatures, putting literatures "in conversation"
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The Preferred Reporting Items for Systematic reviews and Meta-Analyses (PRISMA) statement, published in 2009, was designed to help systematic reviewers transparently report why the review was done, what the authors did, and what they found. Over the past decade, advances in systematic review methodology and terminology have necessitated an update to the guideline. The PRISMA 2020 statement ...
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Not all review articles are published in controlled-publication journals—the "throw-aways." Almost all journals, even the most prestigious ones, publish review articles regularly. They may carry a general label, such as "Review Article" as in the New England Journal of Medicine(NEJM), or "Review(s)" as
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Systematic reviews are usually shorter with less than 10,000 words. B) Elements of a review article Title Function Helping readers to decide whether they should read the text or not. Includes terms for indexing (e.g. in data bases). Elements The title must be informative: • The title has to include important terms.
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Between 10% and 20% of the core text (introduction, body, conclusions). Make sure to have a narrow focus and an explicit research question. Indicate these two points clearly in the introduction ...




	How to Write an Article Review (with Sample Reviews)
1 Understand what an article review is. An article review is written for an audience who is knowledgeable in the subject instead of a general audience. When writing an article review, you will summarize the main ideas, arguments, positions, and findings, and then critique the article's contributions to the field and overall effectiveness. [2]




	How to Write an Article Review: Tips and Examples
Step 1: Define the right organization for your review. Knowing the future setup of your paper will help you define how you should read the article. Here are the steps to follow: Summarize the article — seek out the main points, ideas, claims, and general information presented in the article.




	(PDF) Review Articles: A Critical Review of the pitfalls and guidelines
Review Articles: A Critical Review of the pitfalls and guidelines to effectively conducting and reporting reviews. Authors: Favourate Sebele National University of Science and Technology,...




	PDF Article Review Guideline
Article Review Guideline Note: Remember to use your own words while reviewing the article in light of each of the following sections. 1. Introduction State the objectives (goals or purpose) of the article. What is the article's domain (topic area)? State the article's intended audience.




	Create a form in Word that users can complete or print
In Word, you can create a form that others can fill out and save or print. To do this, you will start with baseline content in a document, potentially via a form template. Then you can add content controls for elements such as check boxes, text boxes, date pickers, and drop-down lists. Optionally, these content controls can be linked to ...
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